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EVAL-M3-102T User Manual

iMOTION™ Modular Application Design Kit

About this document

Scope and purpose

This User Manual provides an overview of the evaluation board EVAL-M3-102T including its main features, key
data, pin assignments and mechanical dimensions.

EVAL-M3-102T is an evaluation-board as part of the IMOTION™ Modular Application Design Kit. This board
features and demonstrates Infineon’s Advanced Motion Control Engine (MCE 2.0) technology for permanent
magnet motors drive over the full speed range.

The evaluation board EVAL-M3-102T was developed to support customers during their first steps designing
applications with running any permanent magnet motor via sensorless sinusoidal control.

Intended audience

This User Manual is intended for all technical specialists who know motor control and high power electronics
converter and this board is intended to be used under laboratory conditions.
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1 Safety precautions

In addition to the precautions listed throughout this manual, please read and understand the following
statements regarding hazards associated with development systems.

Table1 Precautions

Attention: The ground potential of the EVAL-M3-102T system is biased to a negative DC
bus voltage potential. When measuring voltage waveform by oscilloscope, the scope’s

ground needs to be isolated. Failure to do so may result in personal injury or death and
equipment damage

Attention: Only personnel familiar with the drive and associated machinery should plan
or implement the installation, start-up and subsequent maintenance of the system.
Failure to comply may result in personal injury and/or equipment damage.

Attention: The surfaces of the drive may become hot, which may cause injury.

Attention: EVAL-M3-102T system contains parts and assemblies sensitive to Electrostatic
Discharge (ESD). Electrostatic control precautions are required when installing, testing,
servicing or repairing this assembly. Component damage may result if ESD control
procedures are not followed. If you are not familiar with electrostatic control procedures,
refer to applicable ESD protection handbooks and guidelines.

Attention: A control board, incorrectly applied or installed, can result in component
damage or reduction in product lifetime. Wiring or application errors such as under sizing
the motor, supplying an incorrect or inadequate DC supply or excessive ambient
temperatures may result in system malfunction.

Attention: Remove or connect this control board from or to the power drive. Wait three
minutes after removing power from the power drive to discharge the bus capacitors. Do
not attempt to service the drive until the bus capacitors have discharged to zero. Failure
to do so may result in personal injury or death.

Attention: EVAL-M3-102T system is shipped with packing materials that need to be
removed prior to installation. Failure to remove all packing materials which are
unnecessary for system installation may result in overheating or abnormal operating
condition.
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2 Introduction

The EVAL-M3-102T evaluation board is a part of the iIMOTION™ Modular Application Design Kit for drives
(IMOTION™ MADK). In order to run a motor, the mating power board is required to interface this evaluation
board.

The MADK platform is intended to use various power stages with different control boards. These boards can
easily be interfaced through the 30-pin iIMOTION™ MADK M3, or the 30-pin iMOTION™ MADK M3 interface
connector. This board is equipped with 30-pin M3 connector and is intended for power factor correction and
single motor control only.

This evaluation board is designed to give comprehensible solutions of sensorless control of permanent magnet
motors over the full speed range. It provides a capable of 3-phase and type 3 of 2-phase modulation, a micro-
USB connector and on board debugger isolated by digital isolator, and UART interface.

The EVAL-M3-102T evaluation board is available from Infineon. The features of this board are described in the
main feature chapter of this document, whereas the remaining paragraphs provide information to enable the
customers to copy, modify and qualify the design for production according to their own specific requirements.

Environmental conditions were considered in the design of the EVAL-M3-102T, but it is not qualified regarding
safety requirements or manufacturing and operation over the whole operating temperature range or lifetime.
The boards provided by Infineon are subject to functional testing only.

Evaluation boards are not subject to the same procedures as regular products regarding Returned Material
Analysis (RMA), Process Change Notification (PCN) and Product Discontinuation (PD). Evaluation boards are
intended to be used under laboratory conditions by technical specialists only.

Figure 1 shows the evaluation board EVAL-M3-102T. This document explains the features and details of this board
as well as control IC which is IMC102T-F064.

Figurel Evaluation board EVAL-M3-102T
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3 EVAL-M3-102T main features

EVAL-M3-102T is an evaluation control board for motor control applications. The kit demonstrates Infineon’s
motion control IC technology.

Main features of the IMC102T-F064 Motion Control IC are:

e MCE (Motion Control Engine) as ready-to-use solution for variable speed drives

o Field oriented control (FOC) for permanent magnet synchronous motor (PMSM)

e Space vector PWM with sinusoidal commutation and integrated protection features
e Current sensing via single or leg shunt

e Sensorless operation

e Active boost or totem pole PFC control integrated

e Various serial communication interfaces (UART, 12C, SPI)

e Multiple motor parameter support

e 3.3V (default) or 5V VDD power supply

e Flexible host interface options for speed commands: UART, 12C, SPI, PWM or analog signal
e Support for IEC 60335 (‘Class B’)

e Scalable package options

The evaluation board characteristics are:

e Complete kit for running any permanent magnet motor via sensorless sinusoidal control
e 3.3V (default) or 5V VDD power supply

e Micro-USB connector and on-board debugger isolated by digital isolator

e Capable of 3-phase and type 3 of 2-phase modulation

e RoHS complaint

e PCBsizeis 65 x45mm

User Manual 50f41 Revision 1.5
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3.1 Functional description

Figure 2 shows a typical motor control application block diagram using the IMC102T-F064. The IMC102T-F064
provides a built-in closed loop sensorless control algorithm using the unique flexible Motion Control Engine (MCE)
for permanent magnet motors and additionally a boost or totem pole power factor correnction (PFC). The MCE™
consists of a collection of control elements, motion peripherals, a dedicated motion control sequencer and
internal memory to map internal signal nodes. IMC102T-F064 also employs a unique single shunt current
reconstruction circuit in addition to leg shunt current sensing circuit to eliminate additional analog/digital
circuitry.

IPM based or discrete MADK power board

Passive Power Factor

EMI I Correction
Filter (boost/totem pole)

Gate driver

3-phase
inverter

Communication

[ Analog

Current Sensing
single/ leg shunt

Isolated
[ UsB On-Board

Debugger [ S S S

Figure2 Typical Application Block Diagram Using IMC102T-F064
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3.2 IMC102T-F064 pinout description

The main part of the EVAL-M3-102T MADK control board is the IMC102T-F064 iMOTION™ motor control IC.
Figure 3 depicts the pinout of the IMC102T-F064 IC. IMC102T-F064 comes in a 12mm x 12mm 64-pin LQFP

package.
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Figure 3

Pinout of IMC102T-F064

The pin type is specified as follows:

| — digital input

O —digital output

AIN — analog input

« »

Note:

— do not have any signal assigned

Pins that do not have any signal assigned are reserved for future use. These pins should be left

unconnected and neither be connected to ground nor to the positive supply.

User Manual
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Table 2 lists the available pins of IMC102T-F064 with short descriptions. For more detailed information, please
refer to the datasheet or User Manual for iMOTION™ IMC102T-F064 motor control IC.

Table 2 IMC102T-F064 pinout description

Pin# Type Pin Name Description

1 Power VSS ground

2 Power VDD VDD supply power

3 I PARO Parameter page select bit 0

4 I PAR1 Parameter page select bit 1

5 I PAR2 Parameter page select bit 2

6 I PAR3 Parameter page select bit 3

7 - - Not used

8 - - Not used

9 AIN VSP Analog speed reference input

10 AIN REFW Itrip phase W reference

11 AIN IW Phase W current leg sensing

12 AIN IPFCO PFC current sensing

13 AIN NTC external temp sense input

14 AIN VDC DC bus sensing input

15 AIN v Phase V current leg sensing

16 AIN REFV Itrip phase V reference

17 AIN REFU Itrip phase U reference

18 AIN U Phase U leg sensing or single
shunt current sensing

19 AIN VAC2 VAC sense input line2

20 AIN VAC1 VAC sense input linel

21 AIN IPFCREF Itrip PFC reference input

22 AIN IPFCTRIP Itrip PFC input

23 Power VSS ground

24 Power VDD VDD supply power

25 Power VDD VDD supply power

26 - - Not used

27 - - Not used

28 - - Not used

29 0 PWMUL motor PWM phase U low side

30 o PWMUH motor PWM phase U high side

31 0 PWMVL motor PWM phase V low side

32 o PWMVH motor PWM phase V high side

33 o PWMWL motor PWM phase W low side

34 o PWMWH motor PWM phase W high side

35 Power VDD VDD supply power

User Manual 8 of41 Revision 1.5

2018-11-28



EVAL-M3-102T User Manual
iMOTION™ Modular Application Design Kit

(infineon

EVAL-M3-102T main features

36 GK Motor gate kill input

37 - - Not used

38 - - Not used

39 - - Not used

40 - - Not used

41 0 LED Status LED

42 0 PGOUT Pulse output

43 o PFCG1 PFC gate driverl

44 0 PFCGO PFC gate driver0

45 - - Not used

46 - - Not used

47 - - Not used

48 - - Not used

49 Power VSS ground

50 Power VDD VDD supply power

51 - - Not used

52 DIR Direction input

53 - - Not used

54 - - Not used

55 DUTYFREQ Duty/Freq input for speed input

56 - - Not used

57 I RXDO UARTO Receive for SW download

58 o TXDO UARTO Transmit for SW download

59 - - Not used

60 - - Not used

61 - - Not used

62 - - Not used

63 I RXD1 UART1 Receive for host interface

64 o TXD1 UART1 Transmit for host interface
3.3 EVAL-M3-102T board specifications

Table 3 depicts the important specifications of the evaluation board EVAL-M3-102T.

Table 3 EVAL-M3-102T board specifications
Parameters Values Conditions / comments
Host Interface (Not isolated)
UART(TXD1, RXD1) 0-VDD Serial port 1 typical 57600 Bps
AIN 0-VvDD analoginput
User Manual 90f41 Revision 1.5
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Parameters Values Conditions / comments

DIN 0-VvDD digital input

DOUT 0-VvDD digital output

FG 0-30V digital output with open drain
structure

Input

VDD 3.3V (default), 5V Controller supply voltage

DC Bus

DC Bus Scaling 8.20 counts/V 13.3kQ resistor on control board,

DC Bus sensing range 49954V max and 2MQ resistor on power board

Current feedback

Motor Internal Current Feedback 1,3,6,12 Configured by MCEWizard

Amplifier Gain

Motor Current sensing device 0-VDD/Gain Single shunt resistor
Leg shunt resistor

Motor Current Op-amp Non-Inverting default setting

Configuration

Motor Current External 0.833

Amplification Gain

PFC Current sensing device 0-VDD/Gain

PFC Current Op-amp Configuration | Non-Inverting default setting

PFC Current External Amplification | 0.923

Gain

Resolution 12-bit PCB design may reduce the
resolution

Latency 1 pwm cycle

Protections

NTC Temperature shutdown value | 0-VDD (configured by
MCEWizard)

PCB characteristics

Material FR4, 1.6MM thickness
Copper thickness = 10z (35um)

Dimension 65mmx45mm

System environment
Ambient temperature ‘ -40-105°C ‘

34 Pin assignment

Essential information about the connections of the EVAL-M3-102T evaluation board is described below.

User Manual 10 of 41 Revision 1.5
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Table 4 provides the pin assignments of the IMOTION™ MADK-M3 30 pins interface connector J1. This connector
is the interface to the power board.

Table 4 J1- iIMOTION™ MADK-M3 30 pins interface connector for control board
Pin Nr. Pin Details
1 PWMUH 3.3V compatible logic output for high side gate driver-Phase U
2 GND Ground
3 PWMUL 3.3V compatible logic output for low side gate driver-Phase U
4 GND Ground
5 PWMVH 3.3V compatible logic output for high side gate driver-Phase V
6 +3.3V On board 3.3V supply
7 PWMVL 3.3V compatible logic output for low side gate driver-Phase V
8 +3.3V On board 3.3V supply
9 PWMWH 3.3V compatible logic output for high side gate driver-Phase W
10 U+ Shunt voltage phase U
11 PWMWL 3.3V compatible logic output for low side gate driver-Phase W
12 IU- Ground
13 GK Gate kill signal - active low when over current is detected
14 DCBSENSE DC bus positive voltage, scaled in 0-3.3 V range by a voltage divider
15 VTH Thermistor input
16 IV+ Shunt voltage phase V
17 IV- Ground
18 IW+ Shunt voltage phase W
19 IW- Ground
20 VCC Defined for 15V Power Supply (not used in this board)
21 PFCGO 3.3V compatible logic output for PFC gate driver0
22 GND Ground
23 PFCG1 3.3V compatible logic output for PFC gate driverl
24 +3.3V On board 3.3V supply
25 - Not used
26 DCBSENSE DC bus positive voltage, scaled in 0-3.3 V range by a voltage divider
27 VAC+ AC Voltage inputl with high resistive input
28 VAC- AC Voltage input2 with high resistive input
29 - Not used
30 IPFC- Shunt voltage for PFC

Table 5 includes the detail of UART connectors.

Table5 J2- UART Connector
Pin Name Pin Name Connectors
1 TXDO Serial port 0 Output, IMC102T-T064 transmit data to master controller
User Manual 11of41 Revision 1.5
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Pin Name Pin Name Connectors

2 RXDO Serial port 0 Input, IMC102T-T064 receive data from master controller

3 +3.3V +3.3V power supply

4 GND Ground

5 GND Ground

6 +3.3V +3.3V power supply

7 TXD1 Serial port 1 Input, IMC102T-T064 transmit data to master controller

8 RXD1 Serial port 1 Output, IMC102T-T064 receive data from master controller

Table 6, Table 7, Table 8, Table 9, Table 10, Table 11 and Table 12 include the details of test signal pin

connectors.
Table 6 Digital signal test pins J3
Pin Name Pin Name Connectors
1 - Not used
2 PAR3 Parameter page select bit 3
3 - Not used
4 PAR1 Parameter page select bit 1
5 PAR2 Parameter page select bit 2
6 PARO Parameter page select bit 0
Table 7 Digital signal test pins J4
Pin Name Pin Name Connector
1 - Not used
2 - Not used
3 - Not used
4 - Not used
Table 8 Digital signal test pins J5
Pin Name Pin Name Connector
1 - Not used
2 - Not used
3 - Not used
4 - Not used
Table 9 Digital signal test pins J6
Pin Name Pin Name Connector
1 - Not used
2 - Not used
3 DIR Direction input
4 - Not used
User Manual 12 of 41 Revision 1.5
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Table 10 VSP signal test pins J7
Pin Name Pin Name Connector
+3.3V +3.3V power supply
VSP Analog speed reference input
GND Ground
Table 11 Digital signal test pins J8
Pin Name Pin Name Connector
1 PGOUT PG (Pulse Generation) output
2 DUTYFREQ Duty/Frequency input for speed input
Table 12 FG signal test pin J9
Pin Name Pin Name Connector
1 FG open drain output for speed as shown in Figure 30
User Manual 13 0f 41 Revision 1.5
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4 Getting Started with EVAL-M3-102T

In order to run the motor system, a combination of the IMOTION™ MADK control board (EVAL-M3-102T) and the
matching MADK power board (with M3 connector) is required. The iIMOTION™ Software Tools MCEDesigner and
MCEWizard are also required in order to initialy setup the system, as well as to control and fine-tune the system
performance to match users exact needs. This chapter provides more details on setting up the system and
getting started with iMOTION™ MADK development platform.

4.1 Setting up the system

EVAL-M3-102T consists of several functional groups which enable out-of-the-box, fully functional motor control
system combined with additional interfaces and test points for more advanced use cases. Figure 4 shows the
functional groups of the EVAL-M3-102T evaluation board.

1. On-board debugger
2. USB Connecter (X101)
3. Test Signal Pin Connecter
(J8)
4. Test Signal Pin Connecter
3 4 (45) .
5. IMC102T-F064 iMOTION™
2 motor control IC
6. iIMOTION™ MADK-M3 30
11 pins interface connector
10 7. Test Signal Pin Connecter
(J3)
8. iIMOTION™ Link connector
? (J2)
9. VSP Signal Pin Connecter
(J7)
10. Test Signal Pin Connecter
(J4)
1 8 7 11. Test Signal Pin Connecter
(J6)

Figure4  Functional groups of the EVAL-M3-102T evaluation board’s top side

After downloading and installing the iIMOTION™ PC Tools (MCEWizard and MCEDesigner), following steps needs
to be executed in order to run the motor. Refer to chapters 0 and 4.2.2 as well as MCEWizard and MCEDesigner
documentation for more information.

1. Getthe latest "IMC102T-F064 MCE Software Package” available on www.infineon.com/imotion-software
web page.

2. Connect PC-USB connector on the on-board-debugger to the PC via USB cable.

3. Connect EVAL-M3-102T’s M3 30-pin interface connector (J1) to power board (For example EVAL-M3-
CM615PN, see Figure 5).

4. Use MCEWizard to enter the target motor’s system and operating parameters, as well as evaluation board’s
hardware parameters, which will then be used to calculate controller’s digital parameter set representing
complete motor drive system. First click “Calculate” button on the “Verify & Save Page” and then save the

User Manual 14 of 41 Revision 1.5
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drive parameter set into your project directory by clicking “Export to Designer file (.txt)”. Saved Drive
System Parameter File will be later used by the MCEDesigner. Refer to Chapter 4.2.1 or MCEWizard User
Guide for more details.

5. Connect motor phase outputs to the motor.

6. Connect AC power to power input connector and power on system.

7. Start MCEDesigner tool and open MCEDesigner default configuration file (.irc) for IMC102T-F064 controller
(IMC102T_Vxxx.irc) by clicking “File” > “Open”. IMC102T_Vxxx.irc file is included in ”IMC102T-F064 MCE
Software Package” downloaded in step 1.

8. MCEDesigner should automatically connect to the EVAL-M3-102T control board using default COM port
(Indicated by green circle next to “COMx Up” status in the bottom frame of the MCEDesigner GUI). If it
cannot establish the connection, change COM port by doing following steps: (“System” window active) >
Preferences > Connection > Connect using (Chose one of the other available COM ports from the drop-down
menu).

9. Incase the IMC102T-F064 IC on the EVAL-M3-102T is empty (not programmed), which will be indicated by
the pop-up window message after connecting to the MCEDesigner, then use following steps to program the
firmware and the system parameters into the internal SRAM of iMOTION™ IC: Click “Tools” > “Programmer”
and select “Program Firmware and Parameters”. Browse and select the IMC102T-F064_A_Vxxx.ldf file which
was included in the IMC102T-F064 MCE Software Package” downloaded in step 1. Then browse and select
the System Drive Parameters .txt file created in step 4. See chapter MCEDesigner setup overview 4.2.2 for
more details.

10. In case the IMC102T-F064 IC firmware has already been loaded, use following steps to program the system
parameters into the internal SRAM of iMOTION™ IC: Click “Tools” > “Programmer” and select “Program
Parameters”. Browse and select the System Drive Parameters .txt file created in step 4. See chapter
MCEDesigner setup overview 4.2.2 for more details.

11. Start the motor by clicking the green traffic light button in the control bar.

AC Power
Input
PC-USB
Connector
Motor Phase PFC
Outputs Inductor
Figure5 System connection example using EVAL-M3-102T and EVAL-M3-CM615PN
User Manual 15 0f 41 Revision 1.5
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4.2 iMOTION™ development tools and software

The iIMOTION™Development Tool installers for MCEDesigner and MCEWizard are available for download via
Infineon iMOTION™ website (http://www.infineon.com/imotion-software). All supported tools and software
variants are listed there. Please visit this page periodically to check for tool/software updates.

Isolated on-board debugger provides the USB to UART bridge between the PC and the target iIMOTION™ device
with 1kV DC galvanic isolation between the motor drive system (hot side) and the PC/debugger (cold) side. On-
board debugger uses the SEGGER J-Link driver for UART communication with IMC102T-F064. J-Link driver will
be installed during the MCEDesigner installation. In case the driver is not installed properly, please go to
SEGGER J-Link website to download and install the latest J-Link “Software and Documentation pack for
Windows”.

4.2.1 MCEWizard setup overview

After installing the MCEWizard, the shortcut for MCEWizard appears on the Windows desktop. Double click the
shortcut to open the MCEWizard and configure the parameters for evaluation boards or motor. Figure 6 shows
the “Welcome Page” for MCEWizard, where the MADK control board or power board can be selected through
the pull-down list. Infineon keeps releasing new MADK controller and power boards. Therefore, it could happen
that some of the newest power boards are not pre-configured in the MCEWizard tool and cannot be selected
through the pull-down menu. In that case, the user should select any other power board (as similar as possible)
and follow the MCEWizard setup steps by entering the parameter values which are specific to the chosen board.
Make sure both “I have modified the circuit board” and “Enable advanced question” checkmarks are selected.
Please refer to the User Manual of the corresponding power board for additional information.

After selecting the MADK control and the power board, start the MCEWizard system setup procedure by clicking
the “Next” button in the right bottom corner as shown in Figure 6.

Figure6  Welcome Page of MCEWizard
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iMOTION™ MADK system enables users to easily test different combination of control and power board with
their motors. User should be familiar with the system level parameters which are related to the motor used.
There is a very limited number of parameters which are specific to the control board or power board hardware.
Table 13 provides the MCEWizard setup overview for hardware related parameters. Similar tables will be
available in each power board’s User Manual. Combination of this table and the corresponding table of the
power board provides enough information to setup the MADK-based motor drive system in shortest time.

Table 13 MCEWizard setup overview table
Page Parameter Value Comment
Welcome Page | Power Board selecting MADK power board name If no, select similar
power board to modify

Options Page | Motor 1 Shunt Configuration | Refer to the power board App Note

Question 3 Controller Supply Voltage Refer to the power board App Note | VDD is 3.3V by default

Question 19 Max DC Bus Voltage Refer to the power board App Note

Question 23 DC Bus Sensing High Resistor | Refer to the power board App Note

Question 24 DC Bus Sensing Low Resistor | 13.3 kOhm

Question 54 NTC Temperature Shutdown | Calculated as the Section 5.3.2 Refer to the power
value board App Note

Question 63 GateSense Low-Side Devices | Refer to the power board App Note | High is true by default

Question 64 | GateSense High-Side Devices | Refer to the power board App Note | High is true by default

Question 69 Motor 1 Current Input Calculated as the Section 5.1.2

Question 83 PFC Topology Refer to the power board App Note | Boost or Totem-Pole

Question 85 PFC Current Input Calculated as the Section 5.2.2

Question 92 PFC Gate Driver Polarity High | Refer to the power board App Note | High is true by default
Side

Question 93 PFC Gate Driver Polarity Low | Refer to the power board App Note | High is true by default
Side
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After all the MCEWizard questions are answered, the “Verify & Save Page” will be shown as in Figure 7.

Figure7  Verify and Save page for MCEWizard

Click “Calculate” button and “Export to Designer File (.txt)” button to save the parameter file which will be used
by the MCEDesigner in the next steps.

4.2.2 MCEDesigner setup overview

After installing MCEDesigner installer, there is a shortcut for MCEDesigner on Windows desktop. Double click on
the shortcut to open MCEDesigner and then open “IMC102T_xx.irc” file (which was included in the “IMC102T-
F064 MCE Software Package” installed earlier, as instructed in Chapter 4.1) shown in Figure 8.

Figure8 MCEDesigner’s Main Display for EVAL-M3-102T
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MCEDesigner programmer function can be used to program IMC101T-T038 firmware and/or System
parameters. To call this function, click on “Tools” menu and then select “Programmer” in the pull down list.
The pop-up window “Program IMC controller” will show up as in Figure 9.

To program both firmware and Drive System Parameters into IMC102T-F064 (which can happen when
programming for the first time the brand new devices with default factory setting, or when the new version of
iMOTION™ firmware is being downloaded), first click on the “Program Firmware and Parameter” radio button in
the “Program IMC controller” pop-up window. After that, select the Drive System Parameter file created using
MCEWizard by clicking on the “Browse...” button at the end of the “Program Parameter File” row, and then also
select the the IMC102T-F064_A_Vxxx.ldf file (which was included in the “IMC102T-F064 MCE Software Package”)
by clicking on the “Browse...” button at the end of “Program Firmware File” row. Finally, click on the “Start”
button to program the parameter file into the IMC102T-F064 IC.

Figure 9 Program Firmware and Parameter in “Program IMC Controller” pop-up window

To program only Drive System Parameter file into IMC102T-F064, click on “Tools” menu and select
“Programmer” in the pull down list. The pop-up window “Program IMC controller” will show up as in Figure 10.
Click on the “Program Parameters” radio button (this is the default option), and then select the Drive System
Parameter file created using MCEWizard by clicking on “Browse...”. Finally, click on the “Start” button to
program the parameter file into the IMC102T-F064 IC.
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Figure10 “Program IMC Controller” pop-up window

After Drive System Parameter file has been programmed into IMC102 controller, and the motor drive systemis
powered, the MCEDesigner can be used to start/stop the motor, display motor current traces, change the motor
speed, modify drive parameters and many other functions. Please refer to the MCEDesigner documentation for
more details.

Note: On-board Debugger portion of EVAL-M3-102T is galvanically isolated from the controller portion
and the attached power board. In order to program the parameters or firmware to the IMC102T-
F064 controller, the 3.3V DC voltage needs to be supplied to the controller portion of the EVAL-M3-
102T. This voltage can either be supplied by the power board (MADK power boards are designed to
supply the 3.3V to the control board through M1 or M3 connector) or by feeding the 3.3V DC voltage
to the control board through some of the available 3.3V access/test points if the power board is not
attached to the EVAL-M3-102T control board.

All latest firmware file for different type of IMOTION™ control ICs are available for download via Infineon
iMOTION™ website (http://www.infineon.com/imotion-software).
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5 Hardware description of EVAL-M3-102T

This chapter covers hardware design of the EVAL-M3-102T in more details. To enable users to make the EVAL-
M3-102T evaluation board a basis for a new development or modification of their own systems, all necessary
technical data like schematics, layout and components are also included in this chapter.

5.1 Motor Current feedback circuitry

5.1.1 Motor Shunt configuration

Both single shunt and leg shunt topologies are supported by the EVAL-M3-102T control board. The user needs
to make sure that the shunt configuration matches with power board hardware configuration. Please refer to
the power board User Manual for details. The shunt configuration can be changed in MCEWizard by clicking and
selecting in the pull down list marked with red box as shown in Figure 11.

Figure11 Shunt Configuration

5.1.2 Motor External Current feedback configuration and calculation

The shunt resistance Ry, value can be found in the schematics or User Manual for the power board (For
example, the leg shunt resistors are 30mQ for EVAL-M3-CM615PN and 100mQ for EVAL-M3-TS6-606).
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The current input value is product of the shunt resistance in milliohms and gain of External current sense
amplifier as shown in Figure 12.

Figure12 Current shunt feedback and sample timing

Figure 13 depicts IU+ current feedback sensing circuity on EVAL-M3-102T evaluation board. Please note that the
default external amplification gain is less than 1 for current sense in this evaluation board.

+3.3V
Current shunt resistor R10 .
on power board §10Kohm L10W 1% iMOTION
Controller
R13 R12
18

U+ V1 V2
] W WY —
2Kohm 1/10W 1% 1000hm 1/10W 1% l

c21
Ish Rsh

Figure 13 The part of Current feedback on the EVAL-M3-102T evaluation board

Based on the principle of Kirchhoff's voltage law,

V= Vi ~ Vo — I * Rop) # 02 4 I v Ry = —— 2y 4 M0 por,
Rip + Ry3 Rip + Ry3 Rio + Ry3
c tinput = — 110 g 5R
urrent input = Rig + Ryg sh = g e

Based on this calculation, the current input for the MADK combination of EVAL-M3-102T and EVAL-M3-CM615PN
is 25 mV/A, and for the combination of EVAL-M3-102T and EVAL-M3-TS6-606 it is 83.3 mV/A. Please use same
procedure to calculate the current input for other combinations of MADK boards and enter it into MCEWizard.
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Figure 14 Current feedback configuration in MCEWizard for EVAL-M3-102T and EVAL-M3-CM615PN

5.1.3 Motor Internal Current feedback amplifier gain configuration

The iMOTION™ controller on this board has the internal current feedback programmable gain amplifier which
has four gain settings: 1x, 3x, 6x and 12x.

The internal Current feedback amplifier gain can be configured in MCEWizard as shown in Figure 15.

Figure 15 Internal current feedback amplifier gain configuration
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5.2 PFC Hardware configuration

5.2.1 PFC Topology selection

The EVAL-M3-102T control board applies to both of PFC algorithms, boost mode and totem pole. The user
needs to make sure that the topology configuration matches with power board hardware configuration. The
topology configuration can be changed in MCEWizard by clicking and selecting in the pull down list marked
with red box as shown in Figure 16.

Figure 16 The PFC topology choose in MCEWizard for EVAL-M3-102T and EVAL-M3-CM615PN

5.2.2 PFC External Current feedback configuration and calculation

Please refer to the schematic diagram of power board for the shunt resistance value (For example, the shunt
resistors are 30mQ for EVAL-M3-CM615PN and 100mQ for EVAL-M3-TS6-606).

The current input value is product of the shunt resistance in milliohms and gain of External current sense
amplifier as shown in Figure 17.

Figure 17 PFC Current shunt feedback and sample timing
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5.2.3 PFC Internal Current feedback amplifier gain configuration

Figure 18 depicts IPFC- current feedback sensing circuity on EVAL-M3-102T evaluation board. Please note that
the default external amplification gain is less than 1 for current sense in this evaluation board.

3.3V
Current shunt resistor
on power board R6
12Kohm 1/10W 1% iMOTION
V3 Va4 Controller
‘ IPFC- . IPFC- /VV\, /VV\/ IPFC 12 IPECO
R25 R7 C15
1Kohm 1/10W 1%  1Kohm 1/10W 1%1
Ish Rsh 220pF 10V

Figure 18 The PFC Current feedback circuit for EVAL-M3-102T evaluation board

Based on the principle of Kirchhoff's voltage law,

R25 R25 R6

Vom Vs~ (Vpp + Igp * Rgp) ¥ ————— — Igp * Ry, = Voo — R %1
0= Ve = Wop +lonx Ren) e o Ron = R Ry VPP ™ Ry + Ry o o
. R 12
Current input = mRSh = ERsh

Based on this calculation, the current input for the MADK combination of EVAL-M3-102T and EVAL-M3-CM615PN
is 27.69 mV/A, and for the combination of EVAL-M3-102T and EVAL-M3-TS6-606 it is 92.31 mV/A. Please use same
procedure to calculate the current input for other combinations of MADK boards and enter it into MCEWizard.

33v 3
z iMOTION
z Controller
=
§§ g IPEC_12 1oy
3
S
S PFCTRIPREF 21 PECTRIPREF
2
S § . é
e oW
5 ks
o o <
S

Figure 19 The PFCTRIPREF Circuit on the EVAL-M3-102T evaluation board

The PFC’s overcurrent protection circuit is shown in Figure 18 and Figure 19. The lprcrrip_reak €qual to 6.347A for
EVAL-M3-102T and EVAL-M3-CM615PN evaluation board only.
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The calculation formula is as follows,

)"
Rg+ Ry Rg+ R,/ PP
IpFCTRIPpear = — Ry,

S

5.2.4 AC Voltage sensing configuration

Figure 20 shows the schematic of EVAL-M3-102T evaluation board with VAC sense.

20

AC Voltage Sensing inputl [ VAC+ VAC1

C20
4.7nF 10V

15Kohm 1/10W 1%
R11

19

VAC2

AC Voltage Sensing input2 [ VAC- »

R16
C22
4.7nF 10V

15Kohm 1/10W 1%

Figure 20 The AC Voltage sensing schematic

There are two AC voltage sensing modes in MCEWizard, differential mode and single-ended as shown in Figure
21. The default is differential mode for EVAL-M3-102T evaluation board.

Figure 21 Analog inputs on the EVAL-M3-102T evaluation board
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The low side resistor R11 or R16 for the AC voltage sensing resistor divider on the controller board EVAL-M3-
102T is 15kQ, and should be configured in MCEWizard as shown in Figure 22. For the high side resistor value,
please refer to the User Manual of the corresponding power board.

Figure 22 ACVoltage sensing configuration in MCEWizard

5.3 EVAL-M3-102T analog inputs and their MCEWizard setup

Besides current sensing inputs, IMC102T-F064 provides number of analog inputs for different system functions.
Figure 23 depicts analog inputs of the IMC102T-F064 except current sensing inputs.

33V S
g
E
£
g
o &
I T ture Sense input [ VTH il 13
Extemal Temperat
mp p 1 g NTC
—
<&
35S
DC Bus Voltage Sensing input [ DCB —1= 14 \pc
S
S —_
S i
S . o
£ %7 oY
o
&
) 9
VSP Analog Voltage Control input T S
o
;E :
© &
O i
Figure 23 Analog inputs on the EVAL-M3-102T evaluation board
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5.3.1 DC bus sensing configuration

The low side resistor R4 for the DC bus sensing resistor divider on the controller board EVAL-M3-102T is 13.3kQ,
and should be configured in MCEWizard as shown in Figure 24. For the high side resistor value, please refer to
the User Manual of the corresponding power board.

Figure 24 DC bus sensing configuration in MCEWizard

5.3.2 NTC shutdown value calculation and configuration

External NTC Temperature shutdown value can be calculated as shown below and configured in MCEWizard as
shown in Figure 25. For pull-up resistor on evaluation power board and NTC value, please refer to the power
board’s User Manual. The value of pull-up resistor on EVAL-M3-102T is 4.87 kQ (see Figure 23).

Rpull—up on Control board * Rpull—up on Power board

Rpull—up on Control board + Rpull—up on Power board

Rtotal pull-up

RNTC@setting temperature

Vshut down = Vbp

RNTC@setting temperature + Rtotal pull-up

For example, for EVAL-M3-CM615PN, the pull-up resistor on the power board is 9.1kQ. So the total pull-up
resistance calculates to be 3.172kQ.
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The typical value of Ryrc at 100°C is 5.388kQ) for IPM IFCM15P60GD which is used in EVAL-M3-CM615PN. If the
setting temperature is 100°C, the shutdown value should be 2.08V.

Figure 25 External temperature sense input configuration in MCEWizard
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5.3.3 VSP analog input control mode and PGout configuration

VSP analog input control mode can be configured in the options page for MCEWizard by clicking and selecting
in the pull down list marked with red box as shown in Figure 26.

Figure 26 Analog VSP control input mode configuration

There are three input thresholds (percentage of controller supply voltage VDD) used to define the relationship
between VSP input voltage and TargetSpeed.

1. T1 (Input threshold for motor start): if the VSP analog voltage is above this threshold, motor will start
2. T2 (Input threshold for motor stop): if the VSP analog voltage is below this threshold, motor will stop

3. T3 (Input threshold for Max RPM): if the VSP analog voltage is higher or equal to this threshold, TargetSpeed
will be 16384 which is Max RPM.

TargetSpeed

Maximum Vsp = 3.3V or 5V
16384
(Max RPM)

MinSpd

Vsp

T2 ™ T3
(Motor Stop)  (Motor Start) (MaxRPM)

Figure 27 The relationship between VSP Analog Input voltage and TargetSpeed
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After configured the Analog VSP control input mode, the three input thresholds can be set up in the input text
box in MCEWizard marked with red box as shown in Figure 28, or in the pages for Question 9, Question10 and
Question 11.

Figure 28 Three input thresholds configuration for VSP analog input control mode

For Analog VSP control input mode, the motor speed can be calculated by measuring the frequency of PGOUT
signal output of control IC IMC102T-F064. And the pulse generation number per revolution for motor can be
configured in MCEWizard as shown in Figure 29.

Figure 29 PG Pulse Per Revolution configuration
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Motor speed can be calculated as shown below,

PGOUT Freuqency(Hz) = 60s
Pulse Per Revolution

Motor speed(RPM) =

For example, PGOUT frequency is about 80 Hz and Pulse per Revolution is 6, and then the motor speed will be
800 RPM.

By default, VDD is 3.3V for EVAL-M3-102T. The input of VSP and PGOUT (pulse generation output) should be
limited within the voltage range of 0 and 3.3V. While for some application, PGOUT should be connected to
speed measurement circuit. The evaluation board EVAL-M3-102T provides FG (Frequency Generation) signal
with an open drain structure controlled by PGOUT as shown in Figure 30. And FG signal can be pull up to 30V.

E 1 FG

FG

R26
3.3V J7 1000hm 1/10W 5%

1
2 H\ 2
VP I } IRLML2030
3
i& CONL*3

13

Figure 30 VSP Input Connector and level shit schematic for FG
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Schematics overview

Figure 31 shows the schematic of EVAL-M3-102T evaluation board with IMC102T-F064 controller.

3.3v

Duayleg it SEEeERRRE gL ) o
47uhm1/10W5“/; o 5§§§§§?§§§ §§%§ l:l
c3 c2
v £ 2-2”F1°V> N o r«gg‘mwm T owriov
ha (=} (=}
z 2 = A BNE8RSfNOdSER AN
TP10 [ g3g
: m %% 488333558 EER88S o
>
5 j £ IRLMLZDSO
g2 | B o ; Foo a1
VTH > 3.3v} ‘; VDD P0006
TP L A Eﬁf 2% LEDe a8V R22 0Oohm 1/10W 5%
DB PAR. 5 <7 GREEN
Cl4 100F 10V oA | A PrOGo/P000S GD \> R2 9.1Kohm VIOW 5%
Poart 8 | Fourd IMC102T-F064 PeOLD [Tt <
VP
T rerwio ] PO304 | —— LepT R23 )\ A Qohm 110W 5%
[ W11 | ﬁ,ﬁm@' s 2% 38 ¥ RED R3 2Kohm /10W 5% > ,\/\/\/ %
2.21F 10< 1PFC e PoagL |37 PO30L J
K NTC oK Gatekdll ‘ GatekilD>
> VDC ) 33v
g g 'RVEFV L | viAING PWMWH mmf PWMWI L‘ l
S w 16 | RERVIAINY - PWMWL. PWMWI
= s o 5 cr c8 33v
£ S< E o 0.10F 10V 2.20F 10V
3 < 43
9 > ggls
w < 0O
Bo<I2e
r=>>aa a\D
Tl gfzd"“ 1ow 1 R10 10Kohm 1/10W 1%
SN u
L RS MA <10+ ]
e z E Using intemal x3 gain (without extemal Op-amp): 2Kohm 1/10W 1%
e & & R10= 10.0K, R13 = 2.00K, R12 = 100R C21 220pF 10V
E Effective gain =3 *5/6 =2.5 (due to R6 pull up) 3.3V
3
§ Same for Iv and Iw channels
£
€23 4.70F 10V s c1133V R14 - 10Kohm 1/10W 1%
2 0.10F 10v
v
[
i sav VAeH £ VACL i m,\/\/\l ngl\/\/\l L
- 2 l 1000hm 1/10W 19 2Kohm /10W 1%
E 3 C17 220pF 10V Ed
£ e
R6 12Kohm 1/10W 1% ag b
R17 10Kohm 1/10W 1%
e 1PEC e £ VAC2
Wi W % y MLt .
1Kohm 1/10W 1% 1Kohm 1/10W 1% g i R20 R2L
2 3 1000hm 110W 1% 2Kohm J/10W 1%
C15 220pF 10V g o & C24 220pF 10V
&g O«
. o .
Figure 31 The schematics for the EVAL-M3-102T evaluation board
Figure 32 shows the signal test pin connector schematic for EVAL-M3-102T.
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Figure 32 Signal test pin connector schematics for the EVAL-M3-102T evaluation board

5.5 PCB layout overview

The layout of this board can be used for different voltage or power classes of power board. The PCB has two
electrical layers with 35um copper by default and its size is 65 mm x 45 mm. The PCB board thickness is 1.6mm.
Check the Infineon’s website or get in contact with Infineon’s technical support team to get more detailed
information and the latest Gerber-files.

Figure 33 illustrates the top assembly print and top paste layers of the evaluation board.
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Figure33 Top overlay print of the EVAL-M3-102T evaluation board

Figure 34 depicts the bottom assembly print of the evaluation board.
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Figure 34 Bottom overlay print of the EVAL-M3-102T evaluation board
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Hardware description of EVAL-M3-102T

The top layer routing of the PCB is provided in the following Figure 35.

Figure 35 Top layer routing of the EVAL-M3-102T

Figure 36 illustrates the bottom layer routing of the PCB.

Figure 36 Bottom layer routing of the EVAL-M3-102T
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Bill of material

Table 14 provides the complete bill of materials for the EVAL-M3-102T board.

Table 14 Bill of materials
No. | Qty. | Part description Designator | Part Number Manufacturer
1 3 CAP SMD 2.2nF 16V 0603 C1,C6, C8 | CCO603KRX5R6BB10 |Yageo
6

2 9 CAP SMD 0.1uF 16V 0603 C2,C3,C4, |885012206020 Wurth Electronics Inc.
C5, C7,C10,
C11,C13,
C19

3 5 CAP SMD 4.7nF 16V 0603 C9, 885012206012 Wurth Electronics Inc.
C16,C20,
C22,C23

4 5 CAP SMD 10uF 16V 0603 C12,C1s, 885012206014 Wurth Electronics Inc.
C105,
C114,C115

5 CAP SMD 10nF 16V 0603 Cl4 885012206010 Wurth Electronics Inc.

4 CAP SMD 220pF 16V 0603 C15,C17, 885012206020 Wurth Electronics Inc.

C21,C24

7 7 CAP SMD 100nF 16V 0603 C101, 885012206004 Wurth Electronics Inc.
C102,
C103,
€104,
C108,
C110,C111

2 CAP SMD 15pF 16V 0603 C106,C107 | 885012206020 Wurth Electronics Inc.

9 2 CAP SMD 1uF 16V 0603 C109,C113 |885012006003 Wurth Electronics Inc.

10 |1 CAP SMD 4.7uF 16V 0603 Cl12 885012206026 Wurth Electronics Inc.

11 |1 RES SMD 1/10W 470hm 0603 5% R1 RC0603JR-0747RL Yageo

12 |2 RES SMD 1/10W 9.1Kohm 0603 5% | R2,R101 RC0603JR-079K1L Yageo

13 2 RES SMD 1/10W 2Kohm 0603 5% R3, R102 RC0603JR-072KL Yageo

14 1 RES SMD 1/10W 13.3kohm 0603 R4 RCO603FR-0713K3L | Yageo

1%
15 1 RES SMD 1/10W 4.87kohm 0603 R5 RCO603FR-074K87L | Yageo
1%

16 1 RES SMD 1/10W 12Kohm 0603 1% | R6 RC0603FR-0712KL Yageo

17 2 RES SMD 1/10W 1Kohm 0603 1% R7, R25 RCO603FR-071KL Yageo

18 1 RES SMD 1/10W 24Kohm 0603 1% | R8 RC0603FR-0724KL Yageo

19 1 RES SMD 1/10W 470 ohm 0603 1% | R9 RCO603FR-07470RL Yageo

20 4 RES SMD 1/10W 10Kohm 0603 1% | R10, R14, RC0603FR-0710KL Yageo
R17, R108

21 2 RES SMD 1/10W 15Kohm 0603 1% | R11,R16 RC0603FR-0715KL Yageo
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No. | Qty. | Part description Designator | Part Number Manufacturer
22 3 RES SMD 1/10W 1000hm 0603 1% R12,R18, RCO603FR-07100RL | Yageo
R20
23 3 RES SMD 1/10W 2Kohm 0603 1% R13,R19, RCO603FR-072KL Yageo
R21
24 |5 RES SMD 0ohm 1/10W 0603 5% R22, R23, RC0603JR-070RL Yageo
R24,R110,
R111
25 1 RES SMD100ohm 1/10W 0603 5% R26 RC0603JR-07100RL | Yageo
26 |1 RES SMD 1/10W 10kohm 0603 5% | R103 RC0603JR-0710KL Yageo
27 |2 RES SMD 1/10W 330hm 0603 5% R104,R106 | RC0603JR-0733RL Yageo
28 1 RES SMD 1/10W 5100hm 0603 1% R105 RCO603FR-07510RL | Yageo
29 1 RES SMD 1/10W 4.7Kohm 0603 1% | R107 RCO603FR-074KT7L Yageo
30 1 RES SMD 1/10W 1Mohm 0603 5% R109 RC0603JR-071ML Yageo
31 1 CONN HEADER VERT DUAL 8POS J2 61300821121 Wurth Electronics Inc.
2.54
32 1 CONN HEADER DUAL 30 POS RA J 61303021021 Waurth Electronics Inc.
2.54
33 1 CONN HEADER VERT DUAL 6POS J3 61300621121 Waurth Electronics Inc.
2.54
34 1 CONN HEADER VERT DUAL 4POS J4,J5,J6 61300421121 Wurth Electronics Inc.
2.54
35 1 CONN HEADER VERT SING 3P0OS J7 61300311121 Wurth Electronics Inc.
2.54
36 CONN HEADER VERT DUAL 2P0OS J8 61300221121 Wurth Electronics Inc.
2.54
37 CONN HEADER VERT SING 1POS J9 61300111121 Waurth Electronics Inc.
2.54
38 1 FERRITE BEAD 60Q 0603 1LN L101 BLM18PG600 Murata Electronics
North America
39 LED RED CLEAR 0603 SMD LED2 150060RS75000 Waurth Electronics Inc.
40 |2 LED BLUE CLEAR 0603 SMD LED102 150060BS75000 Waurth Electronics Inc.
41 |1 LED GREEN CLEAR 0603 SMD LED1,LED1 | 150060GS75000 Waurth Electronics Inc.
01
42 |1 MOSFET N-CH 30V 2.7A SOT-23-3 Q1 IRLML2030 Infineon Technologies
43 1 0SC 12.0000MHz SMD Q101 12MHz/S/3.2X2.5 Quarz
44 10 TEST POINT PC MINI .040"D TP1/UH, 5001 Keystone Electronics
BLACK TP2/UL,
TP3/VH,
TP4/VL,
TP5/WH,
TP6/WL,
TP7/PFCGO
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No. | Qty. | Part description Designator | Part Number Manufacturer
TP8/PFCG1
TP9/DECSE
NSE,
TP10/VTH,
TP11/GK,
TP12/3.3V,
TP13/GND
45 |1 IC MCU 32BIT 128KB FLASH U1 IMC102T-F064 Infineon Technologies
64TSSOP
46 |1 IC MCU 32BIT 256KB FLASH U101 XMC4200-Q48F256 Infineon Technologies
48VQFN BA
47 1 IC REG LINEAR 3.3V 1A SOT223-4 U102 [FX1117-ME V33 Infineon Technologies
48 |1 DGTL ISO 3.75KV GEN PURP 8SOIC U103 SI8621EC-B-IS Silicon Labs
49 |2 TVS DIODE 17VC WLL-2-1 V101, V102 ESD237-B1-W0201 Infineon Technologies
50 |1 DIODE SCHOTTKY 30V 1A SOD323- V103 BAS3010A-03W Infineon Technologies
2
51 1 CONN RCPT MICRO USB AB SMD X101 ZX62-AB-5PA Hirose Electric Co Ltd
R/A
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7 Reference

[1] iMOTION™IMC100 Series Datasheet

[2] iMOTION™IMC100 Software Reference Manual
[3] MCEWizard User Guide

[4] MCEDesigner User Guide

Note: All listed reference materials are available for download on Infineon’s website
www.infineon.com/imotion. All the iMOTION™ MADK power board’s User Manuals are available at
www.infineon.com/MADK
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IMPORTANT NOTICE

The information contained in this application note is
given as a hint for the implementation of the product
only and shall in no event be regarded as a
description or warranty of a certain functionality,
condition or quality of the product. Before
implementation of the product, the recipient of this
application note must verify any function and other
technical information given herein in the real
application. Infineon Technologies hereby disclaims
any and all warranties and liabilities of any kind
(including without limitation warranties of non-
infringement of intellectual property rights of any
third party) with respect to any and all information
given in this application note.

The data contained in this document is exclusively
intended for technically trained staff. It is the
responsibility of customer’s technical departments
to evaluate the suitability of the product for the
intended application and the completeness of the
product information given in this document with
respect to such application.

For further information on the product, technology
delivery terms and conditions and prices please
contact your nearest Infineon Technologies office
(www.infineon.com).

WARNINGS

Due to technical requirements products may contair
dangerous substances. For information on the type:
in question please contact your nearest Infineor
Technologies office.

Except as otherwise explicitly approved by Infineor
Technologies in a written document signed by
authorized representatives of Infineor
Technologies, Infineon Technologies’ products may
not be used in any applications where a failure of the
product or any consequences of the use thereof car
reasonably be expected to result in personal injury.



‘\ Y MOSCHIP RU g)?ﬂ%?aﬂ:wx KOMMOHEHTOB +7495668 12 70

© BMECTE Mbl CO3LLAEM BYOYLLEE B8 info@moschip.ru

O6LLecTBO C orpaHMYeHHON oTBETCTBEHHOCTBIO «MocHuny WMHH 7719860671 / KIMNM 771901001
Appec: 105318, r.Mockea, yn.LLlepbakoBckas 4.3, odmc 1107

[aHHbIn KOMMNOHEHT Ha TeppuTopun Poccuinickon depepauumn

Bbl MoxeTe npuobpectu B komnaHun MosChip.

[lnsa onepaTtuBHOro ocdopmnenus 3anpoca Bam HeobxoomMmo nepenT No faHHON CChISKe:

http://moschip.ru/get-element

Bbl MoxeTe pa3mecTuTb Y Hac 3aka3 and nboro Bawero npoekTa, 6yab To
cepuiiHoe Npomn3BOACTBO MM pa3paboTka eguHUYHOro npubopa.

B Hawem acCcCopTnMeHTe npencTasiieHbl Begywmne MmpoBblie NMPoOnN3BOANTENIN aKTUBHbIX U
NacCUBHbIX 3JTIEKTPOHHbIX KOMIMOHEHTOB.

Hawen cneumanusauuen sBnseTcs NOCTaBKa 3N1EKTPOHHOMW KOMMOHEHTHON 6a3bl
OBOWHOro Ha3HayeHus, npoaykummn Takmx npounssoantenen kak XILINX, Intel
(ex.ALTERA), Vicor, Microchip, Texas Instruments, Analog Devices, Mini-Circuits,
Amphenol, Glenair.

CoTpynHMyecTBO € rnobanbHbIMU OUCTPUOLIOTOPaMN 3NEKTPOHHBIX KOMIMOHEHTOB,
npegocTraBnseT BO3MOXHOCTb 3aKa3blBaTb 1 MOfly4aTb C MEXAYHAPOOHbIX CKNaaos
npakTuyecku nobon nepeyeHb KOMNOHEHTOB B ONTUMarbHble aAnsa Bac cpoku.

Ha Bcex aTanax pa3paboTKu 1 NPOM3BOACTBA HalLW NapTHEPbI MOTYT NOMy4YnTb
KBanumunpoBaHHy NOAAEPXKY OMNbITHbIX UHXEHEPOB.

Cuctema MeHeXMeHTa KayecTBa KOMNaHum oteevaeT TpeboBaHNAM B COOTBETCTBUM C
rOCT P MCO 9001, TOCT PB 0015-002 n 3C P, 009

Odomc no pabote c OPUANHECKUMU NTULLAMMU:

105318, r.Mockea, yn.lWepbakosckaa a.3, ocdomc 1107, 1118, AL, «LUepbakoBcKkuniny»
TenedoH: +7 495 668-12-70 (MHOrokaHanbHbIN)
dakc: +7 495 668-12-70 (006.304)

E-mail: info@moschip.ru

Skype otaena npogax:
moschip.ru moschip.ru_6
moschip.ru_4 moschip.ru_9


mailto:info@moschip.ru

